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Getting Started 

 

Today we’ll be talking about some of the advanced features of Microsoft Excel at an. This class 

continues on from where our Functions, Formulas, and Graphs class ends. It does require that 

you have a good understanding of how Excel works, including cell references, functions and 

formulas, and sorting.  

 

Topics we cover are: Pivot tables and the “What If” analysis tools of goal seeking, scenarios, and 

data tables.  If you have not taken our Functions, Formulas, and Graphs, it is highly 

recommended before taking this class. 
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 Advanced Reporting Functions: Pivot Tables and Charts  

For more advanced analysis of data, including summary and trending, Excel includes the 

functionality of pivot tables and charts.   

 

Pivot Tables 

What is it? 

A PivotTable allows you to combine and compare large amounts of data in an interactive report.  

You can choose to see different summaries of the source data, as well as get detailed information 

on specific areas that you’re interested in.  You would use a PivotTable when you wanted to 

analyze related totals or be able to switch between summary-type data and detailed data for a 

large data set. 

 

Creating One – 

 

To create a PivotTable, you must first have the data you wish to analyze.  Give some thought to 

what you’re trying to accomplish with the data (what questions are you trying to answer, what 

trends are you trying to see, etc). 

 

To begin the process, you would select the range of cells (data or simple cell) that contains the 

data you wish to analyze.  You can type in the cell references of the range, or use your mouse to 

select the area in the background.  (As with the chart wizard, Excel will take a guess at what you 

want to use, but you will want to double check it).  If you have column headers, include them in 

your selection – it will not affect your outcome, and will make it easier to select data later on.  

 

There is a wizard that will walk you through the creation process.   

 

The first step is to choose where the data you wish to analyze exists (the default option is the 

local Excel spreadsheet), and whether you want to create a PivotTable or a PivotChart.   

  

Step 1: Click on the:  “Filtering” worksheet tab.  

This will demonstrate a simple row-based Pivot 

Table that will display how many boys and girls 

play each sport.  We know that we’re going to 

want to group by the “Gender” and “Sport” 

columns, and count the number of different names 

within each combination of gender/sport. 

 

 

Step 2: Creating the PivotTable by using the wizard.  Begin by 

clicking the Insert tab, then PivotTable and PivotTable.  To get 

the data from the existing spreadsheet, using cells A1:D11, and to 

create a new worksheet for the PivotTable.   

 



Page 3 of 17 

That looks something like this: 

The three main areas of the screen that you will use are the “row fields,” “column fields,” and 

“data items”.  Row fields and column fields are grouping levels, while data items are the entries 

that will be actually counted/summed up/etc. 

 

I have now created a worksheet area for my PivotTable, including a list of fields that are 

available.  I can drag the fields from the list window into the outlined area, and Excel will 

summarize/calculate the data automatically as I do so. 

 

Because we want to group our expenses by the “Sport” field, click and drag “Sport” from the 

Field List into the area that says “Drop Row Fields Here”.  Excel will automatically list out all 

the different types of entries we created in the “Sport” column of the original spreadsheet. 
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Next, we also want to count by gender within each sport, so click and drag “Gender” from the 

Field List into the “Drop Column Fields Here”. 

 

 
 

Finally, we’re able to have the spreadsheet count the unique names that fall into each of these 

groupings.  Drag the field “Name” from the field list into the “Drop Data Items Here” area of the 

screen. 

 

Since we deliberately worked with a small data set, you can confirm the results by doing the 

same calculations by hand: 

3 boys who play baseball (Brad, David, Joseph) 

2 girls who play soccer (Elise, Melissa) 

1 boys who play soccer (Adam) 

4 girls who play softball (Janet, Emily, Laura, Helen) 

6 girls overall (Janet, Emily, Laura, Helen, Elise, Melissa) 
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4 boys overall (Adam, David, Joseph, and Brad) 
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Adding or removing a field 

You can also add or remove fields once you have created a PivotTable, should your needs 

change.  

 

The easiest way to remove an entry is to click the drop down box for that field.  If you click the 

dropdown box for “Sport” you will see the following:         (like auto filtering)  

 

 
 

***Uncheck the box for baseball and it will no longer display. 

   

 

To add one of the field 

values back in, simply follow 

the same steps as removing 

it, but instead add the 

checkmark to display the 

value. 
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Refreshing the Pivot Table 
One caveat about pivot tables: if your source data changes, the pivot table will not see that 

change until you refresh the pivot table.  This means that if you have a spreadsheet of sales 

figures for a given month, and create a pivot table, you will need to refresh the pivot table each 

time you change the original sales figures (adding in new ones, changing existing ones, etc). 

 

You can manually refresh the pivot table one of three ways: Here’s 2 of them: 

1. Right-click in the pivot table and choose “Refresh” from the context menu 

 

2. Click on the pivot table, choose the OPTIONS ribbon, then Refresh 

 

As another option, you can set up the pivot table to automatically refresh when you open it. 

1. Click on the pivot table, choose the OPTIONS ribbon, then OPTIONS on the far left of 

the ribbon to reveal the Pivot Table Options dialog box and select the Data tab.  Refresh 

 

2. Check the box next to Refresh data when opening the file 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

**Please note…the “Refresh data 

when opening the file” is not that 

useful…it’s easier just to click the 

refresh icon. 
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Practice assignment: Click on the worksheet tab titled “PivotTable” to create a PivotTable that 

shows how much you spent in each category of household expenses.  Break it out by month (but 

allow the grand totals to show as well).    Click the Insert Tab…and Pivot Table.   It will 

automatically select the area which you can always adjust.  But…this is the area that we want.  

 

Drop Category into field row…and Month into column field.   

See what we spent = Actual amount – drop into data fields – looks like below results. 

 

One way to do it would end up looking like this (but this isn’t the only way): 
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What-if Analysis Tools (Goal Seeking, Scenarios , and Data Tables) 

 

Goal Seeking 
Goal Seeking is part of the “what-if” analysis tools built into Excel.  You would use this feature 

when you know the result you want from a formula, but not the input values that the formula 

needs to get that result.   For example, if you knew you wanted to save $500,000 in the next ten 

years, you could create a scenario to figure out how much you needed to save each month, or 

what effect the interest rate may have on your progress. 

 

To use goal seeking, first create the formula that you want to work with, an empty cell to hold 

your solution, and any data you need to use in your calculation.   

 

Let’s do a simple example: pretend you own a bakery, and want to make $5,000 in sales.  Your 

pastries are $.80 each.  How many would you need to sell to make your sales goal? 

 

Change to the worksheet called “GoalSeeking1”.  For your sales total cell (B3), create a formula 

that multiplies the price per pastry and the number of pastries sold (=B1*B2).  Fill in $.80 for the 

“price per pastry”. 

 
 

Now run the “Goal Seeking” tool.  You want to set your sales total (B3) to the value of 5,000, by 

changing the number of pastries sold (B2). 

 

Then click Data ribbon, What-If Analysis->Goal Seek..  In the Set Cell box, enter the cell 

reference for the formula you created.  Complete the To Value box with the result you want 

(either a number or a cell reference), and the By Changing Cell box should contain the cell 

reference of the value you want to adjust.   

 

**In Goal Seeking, you can change only 1 variable.  

 
 

 

Click the OK button to run the scenario; you will get a confirmation message when it is 

complete: 
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Click OK again to return to the normal screen, and see the number of pastries you would have to 

sell (6,250 – better get baking!). 

 

You could use this tool on any formula, regardless of how simple or complex, as long as you are 

only trying to change a single variable. 

Scenarios 
Scenarios are a more complex “what if” tool, created by linking together multiple variable cells, 

containing one or more formulas.  You can also create reports based on scenarios, and have 

Excel save them. 

 

 

Let’s continue our example of the bakery; you’ve decided to branch out from just pastries and 

sell coffee as well.  You’re going to sell plain coffee for $1.25 per cup, and Mochas for $2.50 per 

cup. 

 

Change to the worksheet called “Scenario1”.  You can see that in addition to the pastry sales, we 

have a similar section for cups of coffee and mochas.  The formulas to calculate the subtotal of 

sales have already been entered into B3, B7, and B11.  In Cell B14, add a formula to add 

together the three subtotals (=B3+B7+B11). 
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Now let’s create two scenarios; a best-case and a worst-case.   

 

To create a scenario, you first must create a spreadsheet that contains the formula(s) you’re going 

to give different values to.  Then click Data ribbon, What-If Analysis->Scenario Manager..  .  

The Scenario Manager window will open.  Any scenarios you’ve already created will be 

displayed. To create a new one, click Add. 

 

 
 

Give the scenario a meaningful name.  In the Changing Cells box (b2,b6,b10), enter any cells 

that are variable (numbers – not formulas) and you wish to change when running your scenario 

(you can type the names separated by commas, or hold down the Ctrl key while clicking on the 

cells.)  Click OK to add it to your scenarios manager. 

 

The Scenarios Value dialog box will come up, and ask you to enter the values you wish to run.  

Click OK to return to the Scenario Manager screen, and OK again to return to your spreadsheet.  

You can create multiple scenarios on a worksheet. 
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Scenario 1 (“Best Case”) 
Go through the scenario creation process for the best-case, using the cell references for the 

number of pastries/coffee/mochas as your variables.    

 
 

Use the values 100, 150, and 75 for the number of pastries (B2), coffees (B6), and mochas (B10) 

respectively. 
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Scenario 2 (“Worst Case”) – click Add button 

Return to the Scenario Manager and repeat the process.  This time name it “Worst Case” and use 

the values 50, 25, and 10 for your scenario values. 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

*Will automatically use input from 

last scenario. 

*Type in worst case scenario 

numbers…both best and worst will 

be displayed. 
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Creating Scenario Reports 
Creating a Scenario Report will create a new worksheet in the workbook that shows you the 

inputs and results of all the scenarios you have that use the same input cells. 

 

To run a Scenario Summary report, you must have at least one scenario already created in the 

worksheet.  Click Data ribbon, What-If Analysis…>Scenario Manager, and the Scenario 

Manager will appear.   Click the Summary button. 

The Scenario Summary options box will appear.  For a basic report, choose “Scenario 

Summary”.  Choose which cell contains the results, and click OK. 

 

 
 

A new worksheet will be added to your workbook (usually called “Scenario Summary”) that 

shows you the results of your different scenarios. 

 

 

*Create a Scenario Summary report for the two scenarios already created. 

 

Creating a Data Table (one-input) 
Data tables are another “what-if” tool, made up of a range of cells that show how changing 

certain values in a formula affects the outcome.  This is a shortcut for calculating multiple 

variations all at once and showing the results together.   

 

When you create a one-variable data table, the input values must be either in a single column or a 

single row.  You must also create a formula that you want to run the values through, and it must 

Asks for Results Cells…B14 

(Sales) 

*You can edit the Changing   

Cells ($B$2…) and rename 

them accordingly:  

Pastry 

Coffee 

Mocha 

 

Click the Reset button. 
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refer to an input cell.  In this case, an input cell is a “placeholder” cell on the worksheet, so that 

the values from your data table can be substituted in its place. 

 

To create a one-input data table:   Type the list of values you want to substitute (keeping them in 

a single column or single row).  Create the formula you want to use.  For column-oriented data 

tables, type the formula in the row above the first value and one cell to the right.  For row-

oriented tables, type the formula in the column to the left of the first value and one row below. 

 

Once you’ve created the table of values and formula(s), select the range of cells that includes 

both.  Click Data ribbon, What-If Analysis->Data table.  For a column-oriented table, enter the 

input cell reference in the Column input cell box.  For a row-oriented table, enter the input cell 

reference in the Row input cell box. 

 

*In your example workbook, change to the worksheet called “OneInputTable”.  We’ve created 

an example of how your interest rate would affect the monthly payments on a car loan.  Column 

C contains some different interest rate values that we’re going to test out, with our input cell 

being B4 and the payment calculating formula in D3. 

 

*Select the entire column range of cells that contain the values and formula (C3:D4), then click 

Data ribbon, What-If Analysis->Data table.  Since it’s a column-oriented table, enter the input 

cell reference (B4) into the column input cell box.   

 

 
 

*Click OK to perform the calculations.  The “Payments” column will fill in automatically with 

your monthly payments for each of the different interest rates. 
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Once you’ve created a data table, it will automatically recalculate if you change values.  

*Replace some of the values in column C with different interest rates (make sure they’re in 

percentage form…i.e.: 15% to 11%), and watch how the payments change. 

 

Creating a data table (two-input) 
You can also create a data table to calculate results with two variables changing, instead of just 

one.  To continue our example of a car loan, let’s say you want to consider different lengths of 

loans (3 year, 4 year, 5 year) as well as different interest rates. 

 

Like a one-input data table, you’ll begin by creating a table that contains the values you want to 

analyze.  This time, however, you’ll need to make sure to put one variable in columns, and the 

other in rows.  You will also need to make a second input cell (so there’s one for each variable), 

and make sure your formula references both. 

 

Once you’ve built the formula and values, select the cells that contain them.  Click Data ribbon, 

What-If Analysis->Data table.  This time, complete both the column input cell and row input 

cell boxes with the appropriate value. 

 

*Change to the worksheet called TwoInputTable.  It looks similar to before, with some minor 

changes.  Cell C3 now contains the formula, which references both of our input cells: B4 

(interest rate) and B5 (months).   We’ve also added values in D3, E3, and F3 for the different 

loan terms (months) we want to evaluate, while the different interest rates remain in column C 

(C4, C5, and C6). 

 

Select the appropriate range of cells (C3:F6).  Click Data ribbon, What-If Analysis->Data 

table, and complete the column input cell (B4) and row input cell (B5) appropriately. 

 
 

 

Click OK, and the values will fill in. 

*Has to include the 

formula…substitutes the 

original interest rate in BT 

to =…36,48 and 60. 
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As with the one-input table, once you’ve built the formulas and created the table function, you 

can modify your input values if you want to run different numbers without rebuilding the whole 

thing. 

 

Conclusion 

 

You should now have a fairly solid understanding of the most commonly-used tools provided by 

Excel to do data manipulation and analysis: 

- Use pivot tables to create summary or trend-style reports on large data sets 

- Predict the future (…well, sort of) by making use of “What If” scenario tools: 

o goal seeking lets you know what it would take to reach a milestone 

o scenarios show you how different combinations of factors will play out  

o data tables let you substitute a variety of values and compare the results side-by-

side 

 


